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Introduction

SCDOR key result number 3 is "Effective & Efficient Agency & Enterprise Services. The time

spent on just the maintenance (care and feeding) of the average IT infrastructure is 70% ofa technical

person's job. This leaves only 30% for research ofnew technologies and inclusion in new projects

(outside of our area). The amount of business services the Infrastructure team now delivers has exploded

over the last 4 years yet the amount ofpersonnel managing this area remains the same. By being able to

measure and understand "where we are now", "where we want to be", "how are we going to get there"

and "how will we know when we arrive" will help us in being able to better provide SCDOR key result

number 3. This is to be a "continuous" process improvement following industry best practices and

standards for IT operations in a Microsoft environment. Not just a onetime shot.

The methods used to maintain and provide technology services to SCDOR by our internal

infrastructure team to meet business needs have not been measured or compared to business best practices

since I've been here. At times within the infrastructure team there is a feeling ofbeing "overwhelmed"

with the amount of applications, products, installation and delivery of technical services. Is this "feeling"

real or just a product of the way we do business (infrastructure area) internally?

Problem Statement:

The Network Infrastructure at SCDOR today is the most complex it has ever been. Managers in

every division can now access executive information systems, data warehouses, and corporate intranets

for mission-critical decisions. Tax documents are scanned, imaged and stored on replicated storage units.

A data warehouse provides taxpayer lifestyle information versus tax payments. Employees, Contractors

and Temporary hires do most office-related work on computers. With the growth of the Internet and the
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proliferation of web applications SCDOR has made available free to the public 24 hours a day, 7 days per

week, taxpayers, government officials, other agencies, anybody can have and may demanded access to

various systems or internal resources. We also have hundreds of applications, 100 printers, 570 plus

Desktops, 300 plus Laptops, over 870 internal users to keep up with. SCDOR has been moving from a

mixed Netware and Microsoft environment to a total Microsoft environment for the past 3 years. That is

the reason I have chosen to use Microsoft Operations Framework and Infrastructure Optimization Model

to find out where we are now. The solutions provided should naturally fit the Microsoft environment and

SCDOR won't have to reinvent the technology wheel looking for solutions.

What is MOF? MOF Continuous Improvement Roadmap is based on the best practice guidance

contained in MOF version 3 and the IT Infrastructure Library (ITIL). It has three distinct components:

I. MOF Service Management Assessment - is focused on enhancing the performance ofpeople, IT

service management processes, and enabling technologies in the context of improved business value. A

detailed service improvement roadmap is provided, supported by specific key performance indicators to

monitor progress as improvements are implemented.

2. MOF Service Improvement Program (SIP) - guidance is split into two major areas of focus: specific

MOF/ITIL process improvement and generic SIP guidance. This guidance is delivered through a tool that

assists users in identifying their specific pain points and provides focused guidance for remediation. This

guidance is supported by key performance indicators to measure process improvement.

3. MOF Service Management Guidance - is available through a variety of guidance documents and

MOF model descriptions, which link specific Service Management Functions within their

operational context.

Data Collection:

I. Identify one of our crucial IT service-related problems using the MOF assessment tool.
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2. Determine what our pain points are today and where to begin to focus on solutions using the 10M

self-assessment tool.

3. How many personnel, amount and type of applications supported versus other IT shops. Outside

independent reports and internal sources, call tickets, application counts.

4. How much time is really spent on maintenance? Call tickets, conversations with technicians.

5. Define the term maintenance from a SCDOR perspective. Question team members and

stakeholders. http://en.wikipedia.org/wikilPreventive maintenance

6. Determine how many applications we support. Question team members and stakeholders.

7. Determine what kind of applications we support. Software utilities, question team members, in

house and external developers.

Operational Definitions of Critical Terms

MOF - Microsoft Operations Framework is a Continuous Improvement Roadmap is a vehicle for helping

to break the cycle of unrealized improvement goals by making continuous improvement of IT services

more actionable and achievable.

10M - Infrastructure Optimization Model serves as a gauge for IT organizations and provides a logical

roadmap to progress from reactive to proactive IT service management.

HEAT - help desk and request tracking software

Application software - is a subclass of computer software that employs the capabilities of a computer

directly and thoroughly to a task that the user wishes to perform. This should be contrasted with system

software which is involved in integrating a computer's various capabilities, but typically does not directly

apply them in the performance of tasks that benefit the user. In this context the term application refers to

both the application software and its implementation. http://en.wikipedia.org/wikiiApplication software

MS = Microsoft

TAM = Technical Account Manager
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ITIL - Information Technology Infrastructure Library is a set of concepts and techniques for managing

information technology (IT) infrastructure, development, and operations.

Data Analysis:

Before running offand just running the MOF tool I called our Microsoft Technical Account

Manager (Jamie) and she forwarded me information about classes, consulting help and got me in contact

with Jason Osborne, a Program Manager for Microsoft Operations Framework. After my hour long

discussion with Jason I was beginning to feel overwhelmed with the amount and complexity of the

information he was giving, the questions he was asking and the fact they were changing MOF from

version 3 to 4. Jason informed me that the reason for the change was a large percentage of people like

me who were interested in measuring and understanding how to improve and better provide the services

demanded of them found MOF to be complicated, expensive, full time job and possibly non achievable.

Jason mentioned that after taking the MOF assessment I needed to look into taking the 10M assessment.

He said that MOF can help provide operational guidance that will enable SeDOR to achieve mission-

critical system reliability, availability, supportability, and manageability over time. While the

Infrastructure Optimization Model (10M) describes the technologies and key steps that SeDOR can use

to move forward, MOF explains the people and processes required to improve an IT infrastructure.

Together, the 10M and MOF provide a complete model and guidance for IT professionals to use in

process improvement and optimization efforts. The 10M assessment questions really would help to focus

me.

One of the email's Jamie sent me was for a 3 day workshop on MOF. After calling around I

found out the workshop is not in demand so there are no scheduled classes but she would alert me if one

became available. She offered to get a private workshop on site for $20,000. I asked her pricing on an

onsite MOF assessment. This is when a MS consultant comes in and starts the assessment by identifying

and reviewing the current processes and documentation. The problem at this point was the $25,000 plus

minimum price tag. I knew with existing budget issues and other higher priority projects I wasn't going
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to be able to convince my CIO that it is worth spending $20,000 plus to find out where we can improve

our service delivery. What I am hoping for is that after using these tools, gathering and understanding

the data, involving team members and stakeholders and writing this paper we might be able to move

towards the funding needed to really provide an in depth analysis of where our processes can be

improved, pain points eliminated or at least understood.

I decided to take the assessment with a service and not an operational issue in mind. Here is the

Assessment Tool with the questions and my answers. Here is the MOF tool problem summary and

recommendations. After running the MOF assessment tool, reading the problem assessment and

recommendations it was apparent that Jason was right I needed to go farther. The information provided

me with little if any useful information. As I read over the material I wasn't sure if I was going to be able

to move in the direction of "where are we now?" One of the links (in Bright green) on the

recommendations page was to a link to the Microsoft site on Infrastructure Optimization Assessment. I

remembered Jason talking about this and followed the link. As I looked over the material I began to feel

a little better and felt this was an excellent place to find out "where we are now" compared to other

businesses.

The 10M assessment has 60 questions about Identity and Access Management, Desktop, Device,

and Server Management, Security and Networking, Data Protection and Recovery and IT and Security

Process. The 10M also has a more comprehensive assessment of 158 questions. The comprehensive

assessment goes into areas that are not relevant for this paper, but we have scheduled Microsoft for

February 12th to come in and go over the entire 158 questions with us. I scheduled meetings with my

internal team and knowledgeable stakeholders to help answer the 10M assessment questions. I wanted to

make sure we could discuss and agree on what we all felt were valid answers for SCDOR. At first the

questions seemed straight forward and you could answer pretty easily. But as we talked about each

question and really understood what was being asked it provoked good and sometimes spirited talks on

how to best answer it. After taking the assessment our current maturity level in each of the five areas was
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established, lhe next step is to use the model to develop a plan on how to progress through each maturity

level in (X"der to reacb the target level needed to improve that process. 11lc following chart shows the

four maturity levels and there meanings are explained below:

lIasie: MWe ~1l:ht ~·ire.M l1Ie Basic IT infraW\lClure is characterized by manual. localized processes

and minimal central control. as well as nonexistent Of unenfOfccd IT pol icies and standards f(X" security,

backup, image management, and deployment, compliance. and olher oomrnon IT practices.

Standardlled: ..We' .... Gaininl: C')ntroIMTbe Standardized infrastrncture introduces controls tllrough

the use of stlndards and policies 10 manage desk lops and servers: how machines are introduced to tbe

network; and the use of AC1,,-e Diroctory services to manage rc:soure<:s. security policies. and aCC(:Ss

control.

RalionaliHd: MWe f:nable Ruslne.." The Rationalized infrastruClur<: exists where the costs invol,..,d in

managing desktops and serverS are at their lowest, and processes and poli<:ies have matured to playa large

role in SUpporling and expanding the business, $<:curity is proacti,.., "'itb rapid response to threats.

D)'namie: "We're a Slralegie Asort- The Dynamic infrastruetur<: provides strategic value that helps

tbe organization run its busints-< efficiently and

compelitively. Costs are fully controlled. Integration and

collaboration bdwccn users is pervasive. and mobile users

have high levels of service and capabilit;es.
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Below is a chan with the resulls. The five arcas arc highlighted in yellow

Core Infrastructure ODtimization Assessment Results

~ .......41«<1 K.....oom. , .~
.*... ud ,\<,.... M•• - ,

I.......... fl<........ s.n·..

" - ,
Son,• ••d N.,~.,U ,

,,- , .. ,

seDOR Summary:

IT professionals who manage a Ilasic infrastructure find their CIIvirorunenls extremely hard to

COIllrol, have very high desktop and server management costs. arc gCl1Crally very rcactive to security

threats. and have very lillIe positive impact on the ability of the business to bend;t from IT,

Summary: ldemity and ANess Managemenl:

Your Standardized organization may have a uni fied diroctO<)' service. but you do nol have the

means ofenforcing IT policies across the organization. Our recommendation is to deploy tools and

procedures for IT policy CIIforttrnent and Con figuration management.

Summa'}': Desklop. IH\-\«, and Scn--er Management

Your CIIvironmcnt ap]l«lrs charactcri~edby a limited inm.stn>cturc with few or no IT policies and

no desktop standards. Our recommendation is to de!,10y tools and procedures to manage desktop

configuration and updates. operating syslem diversity. and operating system refresh lifceycles

Summary: Sccurit}-- and Nch-mrlting

Your Standardized environmem needs tools and procedures to ~"Dsure stronger security. net-.cork

access. and the performance monitoring of your organi2ation's IT CIIvironmcnt. We recommend

implementing host_hascd fircwalltcchnology on desktops and servCTS. enabling morc secure remole
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access 10 JlCtwork applications, implementing moniloring and wirdess ltthn%gies, as well as oplimi<cing

dala flow to branch offices.

Summary: Uala ....otection and RefOvcl)'

A Slandardiud ol\"ironmenl need~ lool~ and procedures to manage backup and r<:<:ovcry ofdata,

a~ well as service 1",'c1 agr~"Cm~"11t compliance. Our roconlmen<!ation i~ to define Standardized

hackup/r<:Store "",\'kc,; with ser,..ice level agreements and to implement tools and procedures for central

managcment of branch office dala baclrup, msuring lhat baekul"rcslore processes work on ali critical

Belo.., are SeDOR resull. in romparlson 10 (l(her induslries.

Core Infn~rudurc0 limiulion . Indusl .
Go.'ernmenl

Ilasic Standardized Ralionalizcd m"
Tttlmolo2Y 87.00% 12.50% 0.60% 0.00·/0

IT Seeuril 83.70% 7.90"10 6.70"10 1.70%

Jo:ducalion

Ilasic Standardized Ratiol",lizcd () namie

Tttlmolo 93.20% 6.80% 0.00% 0.00%

IT s.xuri M.80% 4.10010 39.20"10 0.00%

RelaU
Basic Standardized Rationalized D namie

Ttthoolo 79.7~ 20.30% 0.00% 0.00"10

IT Socurit 89.80% 6.600/. 3.00"10 0.50"10

finaocial Sen-ic..

llasie Standardized Ralionalized I Dynamic

Ttthool , 7J.OO"1O 25,80% 0.80% 0.50%

IT Socuril 79.20"10 1370% 550"/. 1.60%

Al this time SCOOR has lhe following amount and lypes of enlployecs'
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llelpdcsk call volume from Ifll2000 • 1212007. For any technical ql>$iorIs, issues. mignllions. U!iCI"

accounts. directory righ!s. applic,nion irunalls. updalCS. packaging. millrll1ions. inmutnleturc problcm&.
equipment purehasc&. moves. repairs. phones. Cle ... a llal1 tiekCl i& gel1Cfllted and logged as I call.

COlli Volullle
ooסס,

'000

•

TOlal calls to tile llclpdcsk from the tojl 1S divisiorlli 2004 - 2001
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IRM division Iotal call comparison 10 all OIher SCDOR divisions from 2004 • 2007

ooסס,

ooסס,

'""
o

.lIlM TolJI

As yOIl can sec the Information Resource Management (IRM) division has R.2R8 calls OUI of

17,022. This means IRM the technology side ofSCDOR generale 48.5% ofall ![ealti<;kets .'II SCIJOR.

Whal are some of the changes or raclorli thai have made our services provided morccomplcx?

I. Our costomH or end usu hase has changed from an IT perspective. It used 10 be an inlernal

cnlplo)".", orDOR only, bul n,,," iI'S also taxpayers, oIher agencies and eXlernal non·DOR

p<.nonncl via the internet ne"ding ac«ss 10 ;nlerna[ resources. An inllux of80 plus ContraclO<S

for the SCrfS project who demand dual SCfI'erlli, untcsled application downloads, developmenl
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environments, off-site access, moves, changes, adds at the last minute, has created an

environment in which development is now considered production critical. Why? Because of the

contract personnel costs of $65.00 and up per hour and idle hands cost. This has heightened the

level of stress because now "everything is critical". Also the creation of a typical user account

now involves a minimum of 5 people from Operations and Support.

2. Applications - Because of the sheer number and amount of applications we now support, time

spent on the installation, configuration, updates, and maintenance can take a good amount of

time. Let alone the fact that we are also called to be the "experts". Even though we might not

even use the application, we just installed it. Most of the supervisors aren't sure or don't even

know what application a new employee needs to be productive the first day. They will tell us to

give them "whatever Susie has". Of course that is not good from a security or licensing stand

point. The following table shows some of the applications used / installed on computers

throughout SCDOR.

Total number ofApplications and Versions on Total SeDOR in house developed
seDOR computers scanned via SMS Internet Applications

7065

Applications listed by Vendor name Total number ofApplications pushed out
1200+ via SMS

46

3. Having two Directory Services. Directory services are a centralized and standardized system

that automates network management ofuser data, security and distributed resources and enables

interoperation with other directories. SCDOR's first network used and still does Novell's

Directory Services (NDS). Approximately 3 years ago we also integrated Microsoft's Active

Directory. The two directories User ill's and password's stay synchronized via a Novell product

made for that purpose. The biggest issue's here is having the knowledge to use both sets of

administrative tools, understand directory rights, and user creation. Other issues are the cost of
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maintenaoce for two directories. additi01.. ltime, and added software needed on client machines

to authenticate to both directories.

4. The Imcrncl also brings with it constant security t!lreats Viruses, Spyware, possible data

compromise. password hijacking and time wasted by personncl"sllrfing" the Web. These t!lreats

mllSt Ix aggressively addressed on a daily lJasis by various me1bods. Anti-Virus. Malware.

Spyware. Spam software. hard"'llre and software Firewall., Monthly Security updates. Firrn"'llre

updates. Intrusion detoction systems. cIe ... All of these mllst Ix PUl"hascd. installed. tuned.

monitored. IIpdated and r<-"JlO11s gathered for management. For illStaoce Microsoft Securily

IIpdates jllst for Microsoft prodllCts happen every month On the second Tuesday. this is called

Palch Tuesday. It is perhaps the DXlSI anticipated and feare<! day of the month for our network

administrators and security manager. Do we parch? Don't ...·e patch? What willl:>reak? These

patches or fixes are 10 repair some type of software vulnerability that has been found and mllst be

installed since Ihe previous month's release. But we also dread it too. given the massive amount

ofwork involved in rolling out a dozen or more patches to our 100 pillS servers and hllJ'ldrcds of

Laplop and Desktop's. The following Figure shows the average man hoors per machine per year.

"
"

1
.,

'•.,• "J :, .. ,
• "I ..

• w,,,,"......... 0_. • '-·0.'.......~.... ~.r._..........

This next Figure shows wllat takes place every time new updates. patches. etc .. , come out for

applications. Operating s)ltem'l (Windows XI', Vista, Linux, erc, .j
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r~~~_~_~_'!.o~'';::°gl
;;-,." , , •• "" "'I r " .

.....-. ...._..,..........--
This figure shows the ongoing process of pate II m:magcm",nt

-
".---,-=-
----
-

__ 4 _

B 8"_... <-

- G~li·1

--- §;

~-_..-
S. I)all Sl<>r.g~. The aJJIDUnl of<bta. rcqlllrCtnCf\l5 and how 10 olon,. back up.•~a.s. who bas

righls 10 KC it, change it, dekec it ILaslione from appro~ 20 Ij!;ipbv!q in latc 1999 10 (gabylq
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and has nowhere to go but up. The systems involved with this kind of storage are not the same as

it was even six years ago. Instead of having hard drives inside of your server the drives are stored

on external devices called SANS. SANs are primarily used in large scale, high performance

enterprise storage operations. Equipment is relatively expensive, complicated and needs higher

technical skills to administer.

6. State and Federal regulations and laws are consistently changing on how long, how to store,

what to store, who can access data. Tax rate changes also mean rewriting or updating existing

applications or even writing new ones.

7. Application Development. Development of in house applications must have different

environments to develop these new applications or updates to existing ones. It takes three

separate environments to move or migrate an application from development to production. These

are continuing development, post production, integrated test and then production. Each one of

these environments must match the production environment as close as possible. This means each

one has 3 or more servers to maintain. Since moving development of SCBOS in house and the

SCITS project (moving off of the Mainframe) we now have to maintain two other development

environments.

8. Systems - Filenet, SharePoint, Exchange, Systems Management System, Borland Tool set,

Virtual Center, LCS, CMS, Zytax, Bingo, E Work, Fax on Demand, Data warehouse

9. Technology changes - Anybody who follows the information technology industry can attest to

the fact that the rate ofnew product developments is exponentially growing. Companies once

went 6-12 months without new product announcements. Now, not only do companies introduce

new products (or versions of their products) more often, but many more companies are involved.

10. Remote users - SCDOR provides access to internal resources as never before. But a rising trend

is the idea that "everybody" will have access not just SCDOR employees. This opens up a huge

new avenue of security risks. Users have Fast Cable modem or DSL Internet. Air cards on
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auditor laptops are now used to also allow faster connections to internal resources for real time

data.

11. 24 hours a day, 7 days per week - We are now required to be on call and ready to respond to
users ISSUes.

Implementation Plan

After reviewing the results from the 10M assessment, it became obvious that we needed to focus

on moving from a basic to standardized infrastructure. One area that I felt we can make headway on is

image based deployment technology. We lease our computer equipment at this time and every two years

do a rollout ofnew equipment. Six months before a new rollout we have to decide on a host of things that

will be on the new image. Image what's that? The process is this; we acquire the newest desktop and

laptop computer models we will be leasing. Ask all stakeholders what versions and patch levels of

software they use or don't use anymore. Install the operating system, and all basic software (10-14

applications) that at least 80% of our customers use. Installation of each application requires a long setup

process - files copies, component registrations, runtime installations, and installation of third-party

dependencies - followed by additional configuration, preference setup, and customization. Most

applications do not function properly on secured, locked-down desktops, forcing us to compromise

security for application compatibility (every user is an administrative equivalent on there PC). Finally,

interactions between shared components and different application versions frequently introduce errors

when applications are installed, uninstalled, or upgraded. Also for each time we install another

application, it requires extensive regression testing and deployment efforts before it can be used. Once the

application is installed, users are tied to the computer it is running on. Another issue is the application

licensing costs. If every machine has that application on it then it has to have a paid license. The people

involved include everyone from Desktop, Infrastructure, Security, Training, and Stakeholders to create

this image. We download this image then place it on a few other machines to have customer test their

software to make sure it works. After about 4 - 5 weeks of this we finally can send the image to our
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vendor. Click on this to see the 10 page Image Creation document. Every time we order a new computer,

that new computer comes with our image on it. When someone gets a new computer we tum it on and do

about 30 - 40 minutes of customization for the average user. After that they are ready to be productive.

If they have other applications that must be installed the process takes longer. One of the

problems is the integration of the 10-14 products in the original image. Ifwe can cut that number down

we can get a more stable image, less time and cost up-front in the creation of the image, decrease the

chance of having to make adjustments (fixes) to each computer because of some setting we missed. Also

we have to update the image every month with MS updates, software updates, or other items. Ofcourse if

we don't put the products on our image then they have to be installed some other way. My staffand I met

on 01/28/08 with Microsoft to have them give an overview ofIO. This was to help my team understand

where I am coming from, how this will help them and what I'm try to accomplish with MS 10.

A possible solution to this issue was to look into Application virtualization. At this time it is a

very fluid and emerging technology but one worth looking into. The solutions we are going to look into

are Microsoft Softgrid. The other is Thinstall. The reason we are looking into these two products is that

we are heavily invested in both Microsoft and VMware. VMware just purchased Thinstall.

What is a Virtual application?

Application virtualization isolates an application and the files and settings it needs to run so that it

does not interact with an underlying operating system, other applications and in some cases hardware.

The virtualized application can reside on the desktop in a bubble or it can be streamed down from a server

to a remote user on just about any device or to the local drive.

Why virtualize applications?
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1. Virtual applications are isolated from one another and from the host device, allowing enterprise

desktops to be locked down. The user does not have to be an administrator on the computer.

This decreases the security risk.

2. Because virtual applications do not modify the base operating system state, broken devices can be

swapped out with no impact on the end-user.

3. Applications are not installed on the PC, it also greatly increases application reliability because

they no longer conflict with one another

4. Simpler, automated process for deploying, patching, updating, and removing applications

5. Applications that are not performing properly can be refreshed instantly.

6. Minimizing the number of applications in OS images this decreases image size and complexity

and enables organizations to standardize and consolidate images, simplifying maintenance.

Why not virtualize applications?

1. Inability of a virtualized application to communicate with other applications, for example, if

Excel is isolated virtually and the user attempts to click on a hyperlink to talk to Internet

Explorer, it is unable to follow that link.

2. You mean we have to go back and repackage all the existing applications, remove the old ones

and redeploy them virtually? The time needed to possibly repackage existing applications.

3. You can't virtualize applications like antivirus and the frrewall because they can't be isolated.

Some applications you just don't or can't virtualize.

Check out the following website http://www.stream24-7.com for a look at the future ofapplication
delivery called streaming.

Evaluation method

The following shows our action steps to be taken, timeframes, resources needed and frrst year

costs and a scoring key in making a determination if this is a viable solution.
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Action Steps SoftGrid Thinstall Personnel/ Teams

Talk with vendor to present over view ofProduct 1110/2008 1128/2008 Infrastructure

Read Virtualization Features PDF (shown below) 2/5/2008 2/5/2008 Infrastructure

Acquire a quote from vendor 2/6/2008 1/30/2008 Bob

Acquire trial versions ofeach product 2/8/2008 2/4/2008 Bob

Install and configure product. 3/03/2008 2/28/2008 Infrastructure

Create 2 virtual applications to test 3110/2008 2/29/2008 Infrastructure

Adobe Reader

Full Shot

Test and evaluate applications 3/1112008 3/4/2008 Infrastructure / Training

Stakeholders to test application functionality 3/12/2008 3/1112008 Stakeholders

Data Entry

FSD

IRM

Resolve possible outstanding issues 3114/2008 3/14/2008 Infrastructure

Discuss product limitations and successes. 3112/2008 3/12/2008 All

Both Softgird and Thinstall need to start with a clean PC to create the new application on. This is

a PC which has just the Windows base as installed and nothing else.

Thinstall:

The installation ofThinstall was very quick and easy. It took us approx 2 hours to do this entire

process. You install the Thinstal product on a PC then make the installation directory sharable to anyone
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responsible for the creation of the virtual applications. Thinstal's Setup Capture application works by

taking 2 snapshots for a PC's file system and registry before and after installation the target application.

The Thinstall project is created using the differences between the two snapshots. After the snapshot is

taken we run a build program that creates the application package. After that you can put the new virtual

application out in a sharable area or copy it to the users PC. All the user then has to do is double click on

the application icon and the application is up and running. In fact the whole application is the icon. It took

less than 20 minutes to create our first virtual application Fullshot. After that we virtualized Adobe

Reader version 8 in less than 25 minutes.

Thinstall is different from Softgrid in that it is "agentless". Softgrid requires management

software on the client PC. Since there is no client needed with Thinstall applications can be used on any

computer running Windows. In fact this would allow you to have applications run from a simple USB

stick. Of course, this portability raises questions about controlling software use and licensing after

deployment. At this time there is no centralized management ofhow to distribute the applications to

users.

The purchase price and ongoing costs ofThinstal at this date are as follows using 1000 users:

Purchase price is $35.00 per user $35,000.00

Application Packager (one time fee) $ 5,000.00

Yearly maintenance costs ($7.00 per user) $ 7,000.00

Total 1st year investment $47,000.00

Approx second year costs $7000.00

Thinstal scoring key

Ease of use: (15%) 8

Determine how intuitive and user-friendly the solution is, keeping in mind who the intended user is.
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Administration & Management: (30%) 7

How easy or difficult it is to administer the solution on an ongoing basis.

Installation & Setup: (20%) 8

Rate the complexity and amount of time and effort required to get the solution up and running, relative to

the implementation of solutions of similar size and functionality.

Support: (15%) 7

Rate the level of available customer support, be it in the form of documentation,

online assistance, or live customer support.

Features & Value: (20%) 6

Overall value of the product in relation to similar products offering similar features and capabilities.

Overall score 36

SoftGrid:

The installation of Softgrid was far more complicated than Thinstal. To get a basic system up and
running requires seven components:

• SoftGrid Sequencer (we'll discuss this component in The Art of Sequencing section)

• Microsoft System Center Virtual Application Server to maintain the packages

• SoftGrid Data Store to maintain application information

• SoftGrid Management Console

• SoftGrid Management Server

• An authoritative source for accounts (Active Directory or NT domain)

• SoftGrid Clients used on user PC's to access applications

The process of getting our first virtual application did take a good bit longer than with Thinstal. But the
resulting application ran just the same.

Microsoft's pricing for Softgrid with an Enterprise agreement is in the form of a subscription.

Subscription pricing per month per user is $.59 x 1000 users

Total first year investment

$591.00

$7920.00

Approx second year costs
March 12, 2008 [22]
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SoftGrid scoring key

Ease of use: (15%) 7

Determine how intuitive and user-friendly the solution is, keeping in mind who the intended user is.

Administration & Management: (30%) 8

How easy or difficult it is to administer the solution on an ongoing basis.

Installation & Setup: (20%) 7

Rate the complexity and amount of time and effort required to get the solution up and running, relative to

the implementation of solutions of similar size and functionality.

Support: (15%) 8

Rate the level of available customer support, be it in the form ofdocumentation,

online assistance, or live customer support.

Features & Value: (20%) 9

Overall value of the product in relation to similar products offering similar features and capabilities.

Overall score 39

Both products produced applications that ran fine on our machines. I have included a great product

matrix that shows the existing competitive products and there features. Even though Softgrid has a longer

up front setup than Thinstal the $40000 difference in pricing would be very difficult to make up. Plus

there is the ability in Softgrid to do software metering and to automatically disallow the use of the virtual

application after a set time period.
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Summary and Recommendations

This process of measuring or even understanding "where we are now", "where we want to be",

"how are we going to get there" and "how will we know when we arrive" has been a daunting and

sometimes frustrating undertaking. After a more detailed study and now better understanding of ITIL and

Microsoft's version MOF, I now realize they are complicated, expensive, a full time job and possibly non

achievable in answering my questions in the time frame allowed for this project. (Both are valuable

processes that all IT departments should move towards implementing). The MOF tool did help us in a

very broad sense but it really provided nothing our guts weren't already telling us. The use ofIOM has

really helped us in understanding where to focus and move forward in answering those questions. Just

knowing that information has been good for the team. One of the areas shown needing improvement is in

the area of image based deployment technology. One of the ways we may be able to move towards

achieving this goal is through the use ofvirtual applications. This technology is new and fluid but I

believe it is just the beginning and one of many ways's we will be providing application services to our

customers in the future. Softgrid and Thinstal are just different ways ofdelivering application services to

our customers. We are going to continue to explore in more depth the use of virtual applications and

where they might fit in moving us forward. My hope for this project was to find a way to help the

infrastructure area find some answers to "where we are now", "where do we want to be", "how are we

going to get there", "how are we compared to others"? With the continued use ofIOM our team will

better be able to focus on the areas needing improvement and be able to provide SeDOR key result

number 3 "Effective & Efficient Agency & Enterprise Services".
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Attachment 1

•••
Application virtualization and isolation

solutions feature comparison matrix
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Attachment 2
Image Creation Detail

Windows XP - SP2

o Setup the largest possible (19046MB) NTFS partition

o Set as username and SCDOR as organization

o Name PC FL810img for 810 laptop, FL610img for 610 laptop, FD620img for 620 desktop

o as Administrator Password

o Set Time Zone to Eastern

o Set as "Your Name"

o Install Drivers for NIC, modem, video card, sound card, smart card reader from Dell provided CD

o Laptops ONLY install touchpad & Intel mobile chipset from Dell provided CD

o Install all Windows updates

o Install Windows Media Format 10 series runtime & Windows media Player 10 series

o Set system performance to use "Adjust for best performance"

o Set Personalize Menu to Expand

o Display Properties - Appearance - Change Fonts to Large

o Display Properties - Appearance - Effects - From Standard to Clear

o Remove MSN & MSN Messenger from system components in AddlRemove software

o Set Power Scheme to Never Stand By

o Laptops ONLY Set Close Lid to Stand By

o Laptops ONLY Set Sleep Button to do nothing

o Uncheck display Welcome screen on Screen Saver

o Uncheck Group similar buttons on the taskbar

o Turn offauto hide notification area

o Set NIC to show when connected

o Remove the following icons from the Start Menu: Windows Updates, Windows Catalog, MSN Explorer,
Outlook, Remote Assist, Messenger, Dell Accessories, Desktop Sharing, Program Compatibility Wizard,
Files & Settings Transfer Wizard, and Internet Games.

o Create a c:\WinNT\System32 folder

o Show contents ofc:\Windows\System 32 and c:\Program Files

o Set Virtual Memory to _use default_ minimum and _use default_ maximum

o Set O/S display list to 1 second

o Disable Error reporting

o Set folder options to display detail view and apply to all folders

o Show Control Panel in My Computer

o Auto Arrange and Align to Grid all Desktop Icons
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Accounts: Rename administrator account to ---
Accounts: Rename guest account to _

Devices: Unsigned drivers - silently succeed

GPEDIT.MSC

Local Computer Policy \ Computer Configuration \ Windows Settings \ Security Setting \

Account Policy

Password Policy

o Maximum password age = 0
Local Policies

User Rights Assignment

Deny access to this computer from network

o Remove Dell user; Add new Guest account
Security Options

o
o
o
o Domain Controller: Refuse machine account password changes =

Enable

o Domain Member: Disable machine account password changes = Enable

o Interactive Logon: Do not require CTRL+ALT+DEL = Enable

o Shutdown: Clear virtual memory pagefile = Enabled

Public Key Policies

o AutoenroUment Settings - do not enroll certificates automatically

Local Computer Policy \ Computer Configuration \ Administrative Templates \

Windows Components

Internet Explorer

o Disable Automatic Install ofIE Components = Enable

o Disable Periodic Check ofIE Components = Enable

o Disable software update shell notifications on program launch = Enable
Windows Messenger

o Do not allow Windows Messenger to be run = Enable

o Do not automatically start Windows Messenger initially = Enable
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Windows Media Player

o Do Not Show First Use Dialog Boxes = Enable

o Prevent Desktop Shortcut Creation = Enable

o Prevent Quick Launch Toolbar Shortcut Creation = Enable

o Prevent Automatic Updates = Enable
System

Remote Assistance

o Solicited Remote Assistance = Disable

o Offer Remote Assistance = Disable
Error Reporting

o Display Error Notification = Disable

o Report Errors = Disable
Advanced Error Reporting Settings

o Report operating system errors = Disable
Network

Network Connections

o Prohibit use of Internet Connection Sharing on your DNS = Enable

o Prohibit use ofinternet Connection Firewall on your DNS = Enable

GPEDIT.MSC Continued

Local Computer Policy / User Configuration /

Windows Settings

Internet Explorer Maintenance

Browser User Interface

o Browser Title = SCDOR

Administrative Templates

Windows Components

Microsoft Management Console

Restricted/Permitted Snap-ins
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o Remote Desktops = Disable
Windows Update

o Remove Access to use all Windows Update = Enable
Start Menu & Taskbar

o Remove links and access to Windows Update = Enable

o Remove My Pictures icon from Start Menu = Enable

o Remove My Music icon from Start Menu = Enable

o Add Log Off to the Start Menu = Enable

o Remove Balloon Tips on Start Menu Items = Enable
Desktop

o Remove the desktop cleanup Wizard = Enable
System

o Don't display the Getting Started welcome screen... = Enable

o Turn off Autoplay = Enable for all drives Default turns offautoplay
on all except CD drives. Should we use the Default?

o Windows Auto Updates = Enable Enable prohibits Windows from
searchingfor updates.

*** END of GPEDIT.MSC ***

o Change Local Security Settings Admin Tools> Local Security Settings> Audit Policy - make all Success,
Failure

o Add a Quick Launch bar - remove media player icon

o Uncheck Allow Remote Assistance

o Make My Documents folder point to c:\MyData

o My Computer Window - view menu - arrange icons - uncheck show groups

o Tools menu - folder options - view - uncheck hide protected OS files

o MyData folder - delete My Pictures; create AIMS, Word, Excel, Access, PPoint, TEV, AADARP

o Remove all items from shared documents folder

o Set icon vertical & horizontal spacing to 45

o REGEDIT - HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\System\LegalNoticeCaption
Important Notice!

o REGEDIT - HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\system\LegaINoticeText
The information you are about to review is subject to South Carolina and federal law regarding the
browsing of tax information. You may be subject to criminal prosecution, dismissal from
employment, or penalties if the review ofsuch information is not for legitimate purposes. Only
those whose work duties require the examination of this information should access it.

o In the default user, send to folder, create a shortcut to NotePad

o Laptop ONLY - Turn touch sensitivity down
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CREATE 1st GHOST IMAGE HERE:

Novell Client Install

o Get latest version with all service packs

o Run Setup - Custom Install

o Install- NDPS, Workstation Manager, ZENWorks Application Launcher, and Remote
Management

o Choose IP Only

o Advanced Tab
o Enable Salvage = Off
o Enable Purge = Off
o Enable NetWare Utilities = Off
o Enable Browse To = Off

o Default Capture Tab
o Uncheck NotifY

o Advanced login Tab
o Uncheck Variables Button

o Remove Read Me icon from Start menu

GroupWise Install

o Install from \\dor gwm\vol1\gw7\clientcd\client\win32\setup.exe
o Choose not to put messenger icons out
o Put icons on desktop & Quick launch bar
o Set IP address to 10.84.12.25, port 1677
o Go to address book, name completion search order - Make Novell GW address book 1st and

Frequent contacts 2nd

o Tools, Options, Environment - uncheck launch messenger at startup, uncheck read next after
accept

o Tools, Options, Security - check the. No password Required with eDirectory
o Shut offTips from starting up

CREATE 2nd GHOST IMAGE HERE:

MS Office 2003 Install

o Custom install

o Deselect Outlook

o Run all features from my computer except Outlook and International stuff in the Office Shared
Features section

o Install any service packs

o Hide the language toolbar from the taskbar

o Create Word & Excel icons on the desktop and quick launch bar
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o Open Word

o Default margins should be set at I" top/bottom/leftlright

o Tools> Options>
File Locations tab: Desktops:

Change default file location ofDocuments to
H:\users\%login%\Word

Change Workgroup Templates to H:\shared\wordfiles

Laptops:

Change default file location ofDocuments to c:\MyData\Word

Edit tab:

General tab:

View tab:

Deselect - 'Enable Click and Type'

Deselect - 'Show Paste Options buttons'

Deselect - 'Provide feedback with animation'

Deselect - 'Automatically create drawing canvas when
inserting AutoShapes'

Deselect - Show 'Smart Tags'

Deselect - Show 'Startup Task Pane'

o Tools> AutoCorrect Options
Auto Correct tab: Delete smiley face associated with :)

Smart Tags tab: Deselect - 'Label Text with smart tags'

Deselect - 'Show Smart Tag Actions buttons'

o View> Task Pane
Deselect in order to close "help" pane

Open Excel

o Tools> Options
View tab:

General tab:

H:\users\%login%\Excel

o Tools> Customize
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Laptops: Change default file location to c:\MyData\Excel

Desktops: Change default file location to
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Options tab:

o Open Access

o Tools> Options
View tab:

General tab:

Select 'Show standard and formatting toolbars on two rows'

Deselect - Show 'Startup Task Pane'

A database must be open to do the following:

Laptops: Change default file location to c:\MyData\Access

Desktops: Change default file location to

H:\users\%login%\Acc2000

o Delete New and Open office documents icons from the start menu
Forvus Install

o Run Setup CD (new version)

o Laptop - Copy icon to desktop and quick launch bar
Add /s=def.cnf switch to the Target run line

o Remove Configuration icon from the Start Menu
Fullshot Install

o Run f:\install\FullShot8T\setup.exe
Serial number: ga220xl9w15s56

o Remove icon from desktop
P&I Install

o Run f:\install\Pandl

o Copy interest rate table from f:\public\snapshot\pandi 2k \int.txt to c:\program files\pi\int.txt
TEV Install

o Install from Network

o Create desktop icon
AADARP Install

o Install from Bob Hatcher

o Create desktop icon and make it run in full screen

RODaily Install

o Install from Bob Hatcher

o Create desktop icon and start menu icons

o Copy Access database to c:\mydata\rodaily

March 12, 2008 [35]



Digitized by South Carolina State Library

Daily Reports Install

o Install from Bob Hatcher\

o Create desktop icon

Data Warehouse Install

o Copy from D:\data warehouse to c:\data warehouse

o Copy contents ofD:\mydata to c:\mydata

TaxMaster Install

o Install from Bob Hatcher

o Change path from d:\program files\aims to c:\program files\aims

o Create Desktop icon

o Install Beefsteak.tmz from Bob Hatcher

o Have Windows always open TMZ files with TM4

CREATE 3rd GHOST IMAGE HERE:

Internet Explorer

o Add *.sctax.org to trusted sites

o Change homepage to dragnet.sctax.org/default.htm

o Lock toolbars and move Links bar dwn under address bar

o Set security to medium-low

o Uncheck all options on auto-complete

o Change search companion to not use animated character

o Don't show balloon tips

DEdit toolbars - remove discuss & media; add - full size, size

o Add the following shortcuts to links toolbar - Dragnet, WebMail, SCDOR,

On-track Plugin

o See Scott, get from ot.sctax.org
EWork

o Darlene to install new version
Authorware Player

o Download from www.macromedia.com/software/authorware/download

o Click on the download Macromedia Authorware player button
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JAVA

o Install from java.sun.com/getjava

o Remove shortcut from desktop & start menu

o Uncheck use java 2 from IE advance options (for ework)
Acrobat Reader

o Download from www.adobe.com

o Remove desktop shortcut

o Go to preference> update- manually & uncheck show auto-update confirmation
Quicktime

o Download from www.apple.com/guicktime

o Uncheck file associations & notify me ifother apps want to modify

o Preference - uncheck auto-udpate

o Delete icons from desktop, start menu, quick launce and system try
Authoring Connector

o Install from CD (Doug)

o Change server to dragnet.sctax.org
Flash

o Download from www.macromedia.com
Omniform

o F:\public\web application\omniform filler\
Panagon Web Plugin

o Go to http://panagon.sctax.org/idmoc/

o Set on Link toolbar and rename to FileNetOC

o Empty Recycle Bin

CREATE 4th for Laptops & Final for Desktop GHOST IMAGE HERE:

(Final image for desktop)

o Install VPN Client and Air Card on D810 and D610 (laptops only)

o WAS NOT APPROVED - DID NOT INSTALL: Install MS Streets and Tips (laptops only)

o Empty Recycle Bin

CREATE Final GHOST IMAGE for Laptops HERE:
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Attachment 3

Welcome to me M'crQOQfI OpttJll'"". Framcwo.-l (MOF) Sdf·Asscssment Tool (SAD.

Obj..,I"'..: lbi, lool "designal to <:n.b1e )'<>II 10:

• Better understand me eff""li,'"""", of the IT """vicco .nd 1""""=" in )'QUr <J<gaR,Wioo.
• Oofine • .pecific pr<>blem Qt oppo.-t""ity rtl!J'l"ding)'lUl IT "e"ices and/Q< processes.
• Identify. "",ielY of fullow-up .cti""s bo"'" on intQrm.. ,,,,, you provide.

P~pa""riod; Before stani.ng the assessment. it i. helpful to id""tify your nlQSl cruci.11T OOTVlcc-rclaled {O" IT pr<lCellS­
related problem. Y.... ".11 .Iso wam to identify spccifi.. rell"'d,ng me impact, and e,iden.:e oflhe pr<>blem such a.
lin''''''''l. metric. 0< anecdnl.1 ""idc~.

flow it ,,·ock., The ........m"", I>:ill Slop you throogh me dC"ek>pm""t "fa de,oiled p.-obIem and impact slalement. You ...ill
be asked to """.ider • sone, of potenli,l "",""ces fnr your idenlified problem. Some ofthc areas ,,,II be mo<e applicable 10
)'Our par,icul,r pr<>blem \han ""'er•. YOIl do nOl need to sci"", a p.-obIom 1iOUrc<: £rom "",ry arca <:OIl,idered: )'QU will have
"'" oplioo to i.dentify source, as nOl being applicable ond to continue with the '",,'cy. The object is to ha .... )'QU """sider me
identified p.-obIcrn £rom a variety ofvic"'POinlS to identify SOUr<:es Ihat )'<>II might 1101 h.w already considered,

The " ..tput: Your final report will include "'" ",soosmen, data )'QU klcnlify. a pl"Oblem Slalemal1 )'QU de'elop. 0 summary
ofimpac" on the <J<gani""'ion. and a variety ofcu'tomized "">l-step .<lioo. to take to begin addressing me SJ'CClfi c
p.-obIcm. Anooymous infi::o"malioo aboul the ...vi"" delivery {O" pr"""",, i....,. )'QU mighl be e,penencing "ill be "o<ed in •
MicrOllOfi dal.llbose r",- anal)'li. 10 facilitate fu,ure irnpr,wement. '0 me .""""ment tool No p",.. te data i, asked r",- {O"

""P'ural. and oone will be stored.

The final rcport i. designed to assist you ....ith ccmmWli""'lng me problem "i,hi.n )':JUr ",-g,mi,..tioo .nd to a.,i>1 in me
developmen, of a .....,nes.< case b' mc follow-up acti,i,i"". TIle ..""osmenl OO'pUI will prQVide you wim 0 soIkl basi, for
COnlmUnlcatioo bu, )'QU mighl also find i, helpful '0 edil the ou'pu, further fnr your specific needs.

1. Problem Lo<.tloll

IT problems are <Xlnlmonly <.Il'egori<cd .. an issue "ith an fT se....ice ....h .. messaging. <r ofan fT operot;""w pmuJ> .ueh as
change management Of in<Hlent managemelll

r Pr"""".
f",- the ....vicc problem )'QU h".. idenlified. <:OIl.idcr the quali,y t>f""""cc ,hot i. provldod '0 your cu.,om.....nd
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U"".< from their point ofview.

Problems """." when the .~ce <!efrn"ioo. <us''''''er 'nd u'"" expectation' at><! p<rceptioos and the actual '""'ice
tkhwry or< n", in ahgnmClll. Is lbcrc , p.-<lbIem wilb =vic. quality? If"", ideoti/')' iflbe following aspec" ..e
either missing (undefined) or inatkquate (mi... hgn<dJ' Pica....lcct up 1<>' m,,;mum off"" ;,ems from lb. Ii"
I>:low.

2. Scn-i« Aff.. t<d

Y", identified )<>IIr problem to '"' prim,lily with an IT .....,;c". Speciftcolly. what ...vice Of ,ubscrvice is lb.
prohlem?
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3. Stak.hoIdec

r
r
r

r
r
r

Oe""tor and de,'ie¢ man.gem.n'

Infr.SIr""'.....

Moni'Qrulg

Patch management

St....ge managemen'

Antl_,'i""

Ff&' bo,h """i...... and tT. ~t~ !h_ galeholder l:J""P' m"" likdy '0 e~pcr,ene¢. be ./Teel<:<l by.... be cone.m~
wi,h 'Itl. """,ice-rd.ted p,-obIem. Pte... scleel up 10 a maximum of four i'em. from !he list below.

r
r
r
r
r

•
r

r

r

Roa,d of Direct"""

R""i ...... """iOf mlllagement

R""iness middl. man.g.men'

RltIineoa fi"'t·hn.....n.g.""'nl

F.ntir. bu,iness eommunity

U"",.. of lh. sen'ic.rspeei6e region," departm.m. line o(buoi ...... other bu,in....... it

Nor knownfNor .pplie.b1e (Seleeling !hi. will c1.ar·ou, .ny .nd.lI
seleelion. made .bo,.,.)

r IT Sali... mana gem.."

r IT middle ""'''''gement

r [T lirSl_line """'.gemen'

r IT ....,.,.;<: deh"erym.",.geo-.

r [1' 1""""'" o."oe...

r IT business ""It h.,",,",

'" IT servieclapphca!ion d",.,lormcnt

r IT oper.tlon.
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r
r
r
~

~

r

r

IT .upph<r'

IT delivery limeti""

IT support funcli""

S."ice <ic,lIhelp de;k

IT program ODd ","ojoel management

0 .....,[

NO! knuwnlNoc applicable (SeIe<:1ing this will c1ea,·ou( any and an
...Io:tioll. made above.)

• p", .u,;;rtJ... l" ". ,f

Y"" id<:nlificd the following SlllkdJoida groopus th.... most awaIt of. afk<:te<! by. or """o:rned "';lh the problem
with lb. ldc:m;ty and access managemrnt ""'vice, In cases ""'er. you have identified"",..c!ban three srakobold...
in each group. pl.... idnnify the top three IS n""",.. ,y.

This p'obIem i. primarily being .,perieneed by the ""owing bu,in.,.. ""keholde..

• Entire oosin.,.. C<lIIInlunity

This problem i. primarily being experiC1lced by III. fullo",ing IT srakeholde..;

• IT SO'''';Ce'lpphca1''''' de>.lopm<nl
• Service desklhelp desk
• IT program and pr~t man.gem""l

c ..tomer'••'pectalion uf the ocrvicc:

March 12. 2008 [41 J



Digitized by South Carolina State Library

User" eJlP"ClIllion Oflh. s.~vi<. r r
CUSlomer'S perceplion of1ll•••,'..ice r •
lJ..~, percep1ion oflh.....ic. r r
Prmider's percepl;on of1ll. CUSlomer'S •• peclOlions r •
P"",,,Ie1"s p<rcep1ion <>f1ll. u.......xpcclAlions r r
Service speci ficd by lh. """"dcr r •
S...'ice delivered by lb. J'f'O"idc, r r
Se,vic. communicated by 111. Pf'O'idcr r r
r NO! kno,,"1I!NO! applicabl. (Sele<:ling 1IIis will clea,-
out any and all .<elections m.d<: ak..... )

,l ' i'?l'l'. ,.,1,

.. 111. probl.m ,d.led 10 a PI' I>clween ""y "fth. li.led aspe<:L' o( service q...lily'1

r BelWttT1 Custom <XP"CtoUOO ,,( lb• ...,..,.;c. and CuSlomer'. percepli"" O(lh.....vi""

r BeI"""n CUS10"' «peetolioo 0(111.......,ic. and P",,-ider', percep1ioo "f1ll. custom.....
«peelOl;on.

r IXIWCdl CUSlorner'seXP"Cl.oUOO ,,( the .........., .nd ~vice "P<>Cified by lh. priI,ider

ro1 IXlwe.n CuSlom..... percepli"" of lb. ,."vi<. snd Provider'. p<,ceplion Oflh. cuslom.....
• spec!'ui"".

r Ucl ....en CuO'lom....s perc.pu"" <>flh. """''''' and S<r.'ice <pecified by 1IIe provider

r Between P",,"'ider'. percep1ioo o( Ihe CU..oo'..... e.>;peclalioo, and Se..i<e specified by the
p,o"deT

r- NO! kn<>wnlNot applicable
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Foc the sen'icc problem l"" ha"e idcnlifi«l. ""","<1<1" the q....li'y or servicc lhat i. provided to }<>UC cUSlomer. and
user. &om IT'. poinl of view, Are any oflhe fOllowing a"P"cl. "rthe service eilb... missing oc inadequate'! If th.,..,
area. are "'" """.ider«l a SO\rCe ufthe probkm. ell"""" Nol knowll!Not appli••hIe. Pie......Ieel "I' to a
m..im"", of four i'ems from the lisl below

l'r"fit and ".Iue driven by lhe senice

Bu.iness need .nd CUStomer sali.facli()ll "'-'I'J'OrIe<l by 'he
""",ice

Senicc level agreemenl' (S......) f",- th,. ser>';ce

s.,rviceo underpinmng thi. ser.'ice

Sen,cc op<:cificalion kir Ibis serVIce

Service lewl m.nager fo.- !hi. ><TVlCC

~'icc managemen' prOCOllSCO un<krpinning thi. ><:rVicc

Sj'Stem. un<krpinning Ibi. service

Applic"'ion. \II1derpinning !hi, .."."icc

DalaN"'" lrldcrpinning !hi. S<'r"ice

Nelwock. underpinning !hi. scr<lCe

Service management and """,ilocing 1001. underpinning
!hi. service

Opcr.honallevel .greemenl' (OlA,) lInderpinmng d",

~'.
Undcrp""''''g conlraCt. (UC.) underpmnlng this .....>icc

In'ern.l.nd eaternal """,it<' providen \II1derpinning !hi.
..,."ice

NO! kn""niNlII applicable (Selecling "'IS will dear_
OUI any and.lI seleclion. made above.)

Missing

r

r

r
r

"r
r
r

•
r
r
r

r

'"
r
r

r

r
r
r
r
r

"r
r
r
r

r

"
r

r

r
r

r
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· .l"r"--,.,,

7. Tf<h.niui Pb,fOf"m

l, the pn>blcm with. IlIc savioe rd",cd to a panicular ,cch.nical pl.tform '" .ubs<:rvice'! if ,hI< i•• """'Ce of Ihe
probl<m, "doct tho; pl.tfon," or suhs<n'ieco tha' ,re ",111..- missing", inadequate. Please selcct up to. maximum of
fOllr i,em. from the I;", btlo'"

Mi..ing Inadoquate

Netw.,..k Devic,," ~ ,-
Computing llC'\I;cc< r ~

S,,,,age llC'\Iic", r r
Deployment Services ~ r
NCfW<l<k Servieco r r
FiK\Oo.. 1I Scrv;ccs r r
DIrectory Sen'ices r ~

File and mnt Scrvi""" ,- ,-
Data SCTYices r r
Web Application Scn;ces r r
Infrastrucn..e Management Scrv;""" c ,-
Hackup and Re.:ovcry Scn;ccs r ,-
Ccnific.ale Services r r
Rern<>le Acc.... Services r r
M,ddle"'are ServIce. r r
Me>....ginll ScrviCCll r r

Other. f r r
r

Nor knowrilNor ltppliCllb/e (Sclcetin~ llIi....,11 dear·
out any and.1I ..,Iecti"". mad< above_)
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:, _" -L - _ .......... ,,' " ... ·T_ •

1< the problem 'elated '0 the phase of 'he rr Iif. C}"k .upporting lbe service"
$<:1«1 ,Ito-.. phasn lbo, are rilb'" mi..ing (n<)l <!efiDed 0< performed) or inlldequa'. Pka....1«, up to I maximum
off<>.... iteml &om lb. II" below.

hlluali"n

D....lopm.n'

1)q>loyrnent

Od"...-y (Operallono)

l)«ommi"",oo,ng

T""Hng

Mamtcnance

Support

Admld,.m"ioo

Traldmg

r
Not kno,..nlN", applicabl. ,$<:Iceting lbi. ",ill clea'·

OUt .....y Ind all ..lections made lbo,·•.)

r
r
r
r
r
r
r
r

r
r
r
r

r
r

•
•
r
r

•
r
r
r
r
r

"r

. ".,-- ..," ,~'r .., ".

March 12.2008 [45J



Digitized by South Carolina State Library

9. Problem Source Ranking

When analyzing the potential sources of this problem, you identified several factors as either missing or inadequate.
To further narrow the problem definition, select the top three to five aspects that most contribute to this problem, in
order ofpriority. Select from I through 5 for each aspect, where 1 represents the highest priority.

Top 1 Top 2 Top 3 Top 4 Top 5
Services

c~ C (i'

Customer's expectation of the service
r~ (-. c C"

Customer's perception of the service

Provider's perception of the customer's expectations C C

Service specified by the provider C r c c ("

Service specification for this service r c c c C
Systems underpinning this service

Service delivery for this service r C c (-- ("~

Networks underpinning this service .... r c t. CI.

Network Devices (-- c r r c
Deployment Services

Computing Devices r r c

Directory Services ("" c· rio C·

Defining
C ee. (- ( ..~

Design

Delivery (Operations) r {-

Administration [i' t-- r {-" t-4

r ¥""'~ .",.""~ CI. {,

C- ti-

C t->-~

10. Affected

Specifically, who does this problem affect? Please select up to a maximum offour items from the list below.

March 12, 2008

End-business customers

Board of Directors

Top management
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r
Markeling

r
Sale.

r
Manufacturing

r Kcscarch ond d.,,,lfJI'menl

r
ugll

r
1[uman resow•.,.,
IT cUSlomer.

r
IT u=s

r
IT man.og""eII'

r
IT de~lopm.nl

r
IT """",lions

r
IT ""Wher,

r
IT """in... uni' hoi"",,"

r
IT ser"I~ deh,,,rymanag...,
IT p<""'" o"ner>

r
IT deli~cry fu"<liM

r
IT IIUppOIl funet;,,",
[Tprogram and projocl managemen',
AlIlllakdl<,ldtr.

r
Custom lenl", a <p<:<;,fic a'akehold..- here)

L.'. I. .,.. ,... r.·,. T • - • ,

Whl' is the .lTecl of this problem and its magnilude'! Select the erreCl, and !hen enl... the CUlTent '"olue and the wgc'
<Y desired value. (The... Ire fill-in the blan..... )

If you can q....ntify Ihe effec'o of this ptoblem on Ill. sclkcholder. enler the vlloe< in the clIa", You may en1er values
for each effect you sele<:1ed and you rnly enter Iny vllue thaI "';11 SUpporl the q....nlificali"" of the e/Teen .uch IS
hour•. doll....., per<:cnlllge. etc. En,er the CUlTont ma•..-em..,l 'n !he Current Value column. and the desired &oal or
Lorgel lOr the measure",.,,1 in the Ta,gel Value column. If you .... nOl oble ", quan1ily • panicolar efTeel ., this lim•.
lea'" the entry hllnk.

Pl......lecl up loa ma,imum offoo. ilemsli"om lhe li5l below.
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1. The effect of this problem on IT customers is/are:
Current Value

r
Time

r
Cost

r Risk

~
Delays

r
Unplanned work

r
Agility

r
Speed

r
Satisfaction

r
Profit/revenue

r
Efficiency

r
Productivity

r
Reliability

r
Performance

r-
Quality

2. The effect of this problem on IT process owners is/are:
Current Value

Target Value

Target Value

March 12, 2008

r
Time

r
Cost

r""
Risk

r-
Delays

r
Unplanned work

r
Agility

r
Speed

r
Satisfaction
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r
Profit/revenue

r
Efficiency

~
Productivity

r
Reliability

r
Performance

r-
Quality

3. The effect of this problem on IT program and project management is/are:
Current Value Target Value

r
Time

r
Cost

Risk

~
Delays

r-
Unplanned work

r o

•

Agility

r
Speed

r
Satisfaction

r
Profit/revenue

r
Efficiency

r
Productivity

r-
Reliability

r
Performance

r
Quality

4. The effect of this problem on All stakeholders is/are:
Current Value

r-
Time

r Cost

Risk
[-

Delays

Target Value
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r
Unplanned work

r
Agility

r
'''~

r S.lisfaCl;on

r Profitlteven..e

r
EffiCIency

• ProdUC1'Vlly

r
Keliabilily

r P.,.lOrm""ce

r
Qualuy

Whal c,id<l1C<: <10 you lui". of Ihi' effect?

S•• ke .....doc ur••• hide"..

OT !lelays I ,-- ::Jcu"ome..
IT process Pr<>ductivily f'A"";- ::Jo""e..
IT progr.m
and projeCl 00;10)'> rAr>ocmlal ::J
m.na~enl

All P <>d •• rr:;....onc. ::Jstakeholder. r uC!'V'ly

End ofMOF Self Asscsmenl

March 12. 2008
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Attachmcnt 5
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Allachmcnt 6

10M ASSf.'Ssmcnt

ldenl ity and Access Managen,cnt
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5.000. 'I0Io ,.«<0<)' - , , "" a< , , <0" , ,
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Attachment 7

Maturity Level oomparison
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seDOR Internet applications

SCBOS, SCBOSCMS
Scnetfile, ScnetfileMaint
Ewithholding, EwithholdingMaint, EwithholdingAdmin
Esales, ESalesMaint
DORBOS, DORBOSMaint
DOREPAY,DOREPAYMaint
ACH, ACHMaint
Penalty and Interest Calculator
Credit Card, Credit CardMaint
EDSR

Datasources
CMS SCGIMS-Dragnet-DOR

Back
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